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Safety precautions 
Observe the following safety precautions before using this product and any associated 
instrumentation. Although some instruments and accessories would normally be used 
with nonhazardous voltages, there are situations where hazardous conditions may be 
present. 
This product is intended for use by qualified personnel who recognize shock hazards 
and are familiar with the safety precautions required to avoid possible injury. Read and 
follow all installation, operation, and maintenance information carefully before using the 
product. Refer to the user documentation for complete product specifications. 
If the product is used in a manner not specified, the protection provided by the product 
warranty may be impaired. 
The types of product users are: 
Responsible body is the individual or group responsible for use and maintenance of 
equipment, for ensuring that the equipment is operated within its specifications and 
operating limits, and for ensuring that operators are adequately trained. 
Operators use the product for its intended function. They must be trained in electrical 
safety procedures and proper use of the instrument. They must be protected from 
electric shock and contact with hazardous live circuits. 
Maintenance personnel perform routine procedures on the product to keep it 
operating properly, for example, setting the line voltage or replacing consumable 
materials. Maintenance procedures are described in the user documentation. The 
procedures explicitly state if the operator may perform them. Otherwise, they should be 
performed only by service personnel. 

Service personnel are trained to work on live circuits, perform safe installations, and 
repair products. Only properly trained service personnel may perform installation and 
service procedures. 
Keithley Instruments products are designed for use with electrical signals that are 
measurement, control, and data I/O connections, with low transient overvoltages and 
must not be directly connected to mains voltage or to voltage sources with high 
transient overvoltages. Measurement Category II (as referenced in IEC 60664) 
connections require protection for high transient overvoltages often associated with 
local AC mains connections. Certain Keithley measuring instruments may be connected 
to mains. These instruments will be marked as category II or higher. 
Unless explicitly allowed in the specifications, operating manual, and instrument labels, 
do not connect any instrument to mains. 
Exercise extreme caution when a shock hazard is present. Lethal voltage may be present 
on cable connector jacks or test fixtures. The American National Standards Institute 
(ANSI) states that a shock hazard exists when voltage levels greater than 30 V RMS, 
42.4 V peak, or 60 V DC are present. A good safety practice is to expect that hazardous 
voltage is present in any unknown circuit before measuring. 
Operators of this product must be protected from electric shock at all times. The 
responsible body must ensure that operators are prevented access and/or insulated from 
every connection point. In some cases, connections must be exposed to potential 
human contact. Product operators in these circumstances must be trained to protect 
themselves from the risk of electric shock. If the circuit is capable of operating at or 
above 1000 V, no conductive part of the circuit may be exposed. 



 

 

Do not connect switching cards directly to unlimited power circuits. They are intended 
to be used with impedance-limited sources. NEVER connect switching cards directly to 
AC mains. When connecting sources to switching cards, install protective devices to 
limit fault current and voltage to the card. 
Before operating an instrument, ensure that the line cord is connected to a 
properly-grounded power receptacle. Inspect the connecting cables, test leads, and 
jumpers for possible wear, cracks, or breaks before each use. 
When installing equipment where access to the main power cord is restricted, such as 
rack mounting, a separate main input power disconnect device must be provided in 
close proximity to the equipment and within easy reach of the operator. 
For maximum safety, do not touch the product, test cables, or any other instruments 
while power is applied to the circuit under test. ALWAYS remove power from the 
entire test system and discharge any capacitors before: connecting or disconnecting 
cables or jumpers, installing or removing switching cards, or making internal changes, 
such as installing or removing jumpers. 
Do not touch any object that could provide a current path to the common side of the 
circuit under test or power line (earth) ground. Always make measurements with dry 
hands while standing on a dry, insulated surface capable of withstanding the voltage 
being measured. 
For safety, instruments and accessories must be used in accordance with the operating 
instructions. If the instruments or accessories are used in a manner not specified in the 
operating instructions, the protection provided by the equipment may be impaired. 
Do not exceed the maximum signal levels of the instruments and accessories, as defined 
in the specifications and operating information, and as shown on the instrument or test 
fixture panels, or switching card. 

When fuses are used in a product, replace with the same type and rating for continued 
protection against fire hazard. 
Chassis connections must only be used as shield connections for measuring circuits, 
NOT as protective earth (safety ground) connections. 
If you are using a test fixture, keep the lid closed while power is applied to the device 
under test. Safe operation requires the use of a lid interlock. 

 

If a screw is present, connect it to protective earth (safety ground) using the wire 
recommended in the user documentation. 

 

This symbol on an instrument means caution, risk of danger. The user should refer 
to the operating instructions located in the user documentation in all cases where 
the symbol is marked on the instrument. 

 

This symbol on an instrument means caution, risk of electric shock. Use standard 
safety precautions to avoid personal contact with these voltages. 

 

This symbol on an instrument shows that the surface may be hot. Avoid personal 
contact to prevent burns. 
This symbol indicates a connection terminal to the equipment frame. 

 

If the mercury symbol is on a product, it indicates that mercury is present in the 
display lamp. Please note that the lamp must be properly disposed of according to 
federal, state, and local laws. 

WARNING This heading in the user documentation explains dangers that might result 
in personal injury or death. Always read the associated information very 
carefully before performing the indicated procedure. 

CAUTION This heading in the user documentation explains hazards that could 
damage the instrument. Such damage may invalidate the warranty. 



 

  

Instrumentation and accessories shall not be connected to humans. 
Before performing any maintenance, disconnect the line cord and all test cables. 
To maintain protection from electric shock and fire, replacement components in mains 
circuits — including the power transformer, test leads, and input jacks — must be 
purchased from Keithley Instruments. Standard fuses with applicable national safety 
approvals may be used if the rating and type are the same. Other components that are 
not safety-related may be purchased from other suppliers as long as they are equivalent 
to the original component (note that selected parts should be purchased only through 
Keithley Instruments to maintain accuracy and functionality of the product). If you are 
unsure about the applicability of a replacement component, call a Keithley Instruments 
office for information. 

To clean an instrument, remove power from the instrument. Use a damp cloth or mild, 
water-based cleaner. Clean the exterior of the instrument only. Do not apply cleaner 
directly to the instrument or allow liquids to enter or spill on the instrument. Products 
that consist of a circuit board with no case or chassis (e.g., a data acquisition board for 
installation into a computer) should never require cleaning if handled according to 
instructions. If the board becomes contaminated and operation is affected, the board 
should be returned to the factory for proper cleaning and servicing. 
Safety precaution revision as of January 2013. 
 

 

  



 

 

What is KickStart? 
KickStart Instrument Control Software lets you start making 
measurements in minutes without complex instrument programming. 
Kickstart allows you to do I-V characterization, data acquisition and 
logging, and power supply control on a variety of Keithley products. 
The software controls instruments through any of the standard 
interfaces: LAN, USB, and GPIB. Data can be displayed in a graph, 
chart, or both formats. All data can be stored and exported for 
further analysis in a spreadsheet software such as Microsoft® Excel®. 
 

About the KickStart documentation 
This guide contains basic instructions for the KickStart software. A 
copy of this guide is available by clicking the blue help icon in the 
upper right corner of the KickStart interface.  
 

Additional user information is available in the KickStart software 
help files. Each test-type plug-in has a tab with additional 
information specific to the test type. 

Additional information specific to the Keithley instruments that you 
have is available on the Keithley Instruments website at 
www.tek.com/keithley. 
 

Contact information 
If you have any questions after you review the information in this 
documentation, please contact your local Keithley Instruments office, 
sales partner, or distributor. You can also call Keithley Instruments 
corporate headquarters (toll-free inside the U.S. and Canada only) at 
1-800-935-5595, or from outside the U.S. at +1-440-248-0400. For 
worldwide contact numbers, visit the Keithley Instruments website at 
www.tek.com/keithley. 

 

 

  



 

  

Install and launch the software 
You can download the KickStart software from the downloads 
section of www.tek.com/keithley. 

The KickStart software requires the appropriate version of 
Microsoft .NET Framework. For KickStart version 1.7 and earlier, 
Microsoft .NET Framework 4.0 is required. For KickStart version 
1.8 and later, Microsoft .NET Framework 4.5 is required. The 
KickStart installer will detect if the appropriate version of 
Microsoft .NET Framework is not installed and prompt the user to 
install it if necessary. 

To install the KickStart software: 
1. Double-click the KickStartSetup.exe file to start the 

installation. 

2. Follow the prompts to complete the installation. 

To launch the KickStart software: 
From the Start menu, select: 

 
 
 

You can also navigate to All Programs > Keithley Instruments > 
KickStart > KickStart. 

Only connect to instruments using one of the supported interfaces 
(USB, GPIB, or LAN). KickStart scans these remote interfaces and 
discovers connected instruments if instruments are configured 
properly. For more information on how to configure the remote 
interfaces of instruments, please refer to instrument manuals. 

To select the Chinese language option: 
1. Click the Settings tab. 

2. In the Select Language menu, select Chinese. 

3. Restart KickStart software to apply the changes.  

 



 

 

 

Create and run a test 
The following topics guide you through the steps to set up a 
KickStart test. 

Step 1: Create a new test project 
To use KickStart, you must create a new test project or open an 
existing test project file, if you have one. 

The KickStart software installation includes one or more example 
projects. These examples are installed on your computer in the My 
Documents\Keithley Instruments\KickStart folder. 
This is also the default location for projects that you create. 
 

To create a new test project: 

 

1. Select the File tab and click New. The Save As dialog box opens. 

2. Go to the location where you want to save your test projects.  

3. Enter a name for your test. 

4. Click Save. KickStart creates a new folder with the name of your 
test project. 

KickStart test files have a .kst file extension. Creating the test project 
does not create the .kst file. You must select an instrument and test 
type before you can save your test to a .kst file. 

 
 



 

  

To open an existing test project on your computer: 
1. From the File tab, click Open. The Open dialog box is displayed. 

2. Go to the folder that contains the test that you want to open. 

3. Select the .kst file. 

4. Click Open. 

When you create or open a test project, the KickStart interface 
changes. You can now see large icons at the bottom of the screen 
that represent the remaining steps to set up and run your test. The 
following topics describe these steps. 

 

 

Step 2: Select an instrument 
To select an instrument: 
1. Click the Select Instrument icon. A panel opens that shows 

the instruments that are connected to your computer. 

 

2. Select the instrument that you want to connect and right-click. 

3. Select Add Instrument. 

KickStart searches for compatible instruments connected with GPIB, 
USB, or LAN interfaces. If you search for the instrument using LAN, 
the instrument and computer must be on the same network subnet. 
To remove this option, clear the Discover LAN Instruments option.  
For more information about remote communication interfaces, refer to 
the Reference Manual for your instrument. 

To connect an instrument not shown in the Instument 
Configuration Panel: 
1. Check the connections to the instrument. 

2. Click the Instruments on the ribbon. 

3. Click Refresh Instrument Discovery. 

Some instruments require you to set the command set to either SCPI 
or TSP. Check the Read Me file for this requirement. 



 

 

Step 3: Select the test type 
KickStart installs compatible test types for different instruments. You 
can only select test types that are compatible with the selected 
instrument. Click the Select Test Type icon to open the Test Types 
panel. 

The Communication Terminal is a common test type available to any 
instrument. You can use this interface to send commands to and 
view output from the instrument. 

You can also open the Test Types panel by clicking the Test Types 
tab on the left side of the interface. 

To select the test type: 
1.  Right-click the test type and select Add Test Type. A new tab 

opens with the name of your test in the upper left part of the 
KickStart interface. 

2. On the ribbon, click Save. KickStart saves your test file with 
a .kst extension in the folder that you specified when you 
created your new test project. 

 

Select your test settings 

The settings for your test depend on the test type you are using. For 
more information about the settings for your test type, open your test 
and click the Help tab in the main test window. For additional 
information about how to use your instrument, refer to the manuals 
for your instrument at www.tek.com/keithley. 

Step 4: Run the test 
Once you have configured your test settings, you are ready to run 
your test. 

1. Click the Start Test icon in the lower right corner of the 
interface. 

2. To view the results of the test, click the Sheet or Graph tab. 

3. After running the test, you can customize the graph display. 

Select your data view settings 

Some of the KickStart test-type plug-ins have options to view and 
save your test data on the Graph and Sheet tabs in the main test 
window. The following topics describe these options. 

 

 



 

  

Graph tab 

You can plot your data as your test is running and change the settings 
for the test data to change the view of the graph.  

Data from your test is saved with the project and remains with the test 
until you repeat the test. Every time a test is run in the same test 
project, the previous data is overwritten if the Clear Data Before 
Execute Test check box is selected on the Settings tab on the ribbon. 

 

To save the graph to a .png file, from the File menu, select the 
Graph Image option. 

When you run your test, your data is graphed in real time on the 
Graph tab. Use your mouse to zoom in or out on the graph view. 
You can set X-axis and Y1- and Y2-axis settings for measurement 

value or time. You can also select linear or logarithmic representation 
of your data, and you can change the color of graphed lines.  

Sheet tab 

If your test type supports the sheet view, you can see your data in a 
sheet view after execution of your test. To save the data to 
an .xlsx or .csv file format, from the File menu, select the Excel 
Format or CSV Format option. 

 

  



 

 

Customizing the interface 
You can customize the appearance of the KickStart interface: 

 Hide or show the ribbon. Click the arrow in the upper right 
corner of the ribbon to hide or show it. 

 

 Display multiple windows in the main test window. Select a 
tab and drag it to the graphic in the center of the main test 
window. The figure below shows the screen as the sheet tab is 
clicked and dragged to the right side of the window. 

 

Changes you make to the layout and views in a project are saved with 
the project. 



 

  

Frequently asked questions 
Why am I unable to move to step 2 (selecting a test type) when 
creating a new test? 

When you create a new test in KickStart, you must add the 
discovered instrument. Right-click the instrument and select Add 
Instrument. 

Once you have added an instrument, you can move to step 2, Select 
Test Type. To select the test type, right-click the test and select Add 
Test Type. 

Why are no LAN instruments displayed in the Instrument 
Configuration window? 

There is a check box on the Instrument Settings tab in the ribbon 
that enables or disables discovery of LAN instruments. Verify that 
instrument discovery is enabled. 

Only the instrument simulators are displayed in the Instrument 
Configuration panel. Why can’t I see my instrument? 

Ensure that your instrument is properly connected and configured. 
Click Refresh Instrument Discovery in the Instruments menu. 
Consult your instrument reference manual for further 
troubleshooting on connecting to a remote interface.  

How do I know which instrument is selected for testing by 
KickStart? 

On the Instruments tab, select the Identify Selected Instruments 
icon. The instrument that is selected for testing displays a message 
that shows which channel it is set to. 

Why is my instrument not communicating with KickStart? 

First make sure your instrument model is supported by KickStart. As 
of KickStart version 1.8, the list of supported instruments is as 
follows: Keithley Models 2450, 2400, 2280, 2700, 2701, 2750, 2460, 
DMM7510, and 2461. See the latest version of the KickStart release 
notes for the latest updates. Second, if you have a Keithley Model 
2450, 2460, or 2461, set your instrument to TSP mode. 



 

 

Next steps 
For more information and to view documentation specific to your 
instrument, see the Keithley Instruments website, 
www.tek.com/keithley. 
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